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An Important Warning  

Copy your sequences to a safe place because your computer WILL die 

Make a copy of the sequence installation file(s) and the store receipt (including the unique sequence serial number). Put 

this information in a safe place for future reference. Best practice is to keep this information on a different storage 

device than your current computer. If the computer stops functioning for any reason, your purchased sequence can be 

installed on another computer. 

This sequence is licensed to you and is for your use only. This license cannot be transferred. Please do not share this 

sequence with others. A unique serial number is embedded in the sequence and can be traced back to the original 

purchase. 

Bottom line: make a backup copy of your sequences and store it somewhere else other than the computer you are 
working on. We have no way to restore your local files if your computer crashes. 

http://www.lightorama.com/
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Installation Quick Start  

You bought a sequence from http://sequences.lightorama.com. Now what? 

After the successful purchase of a Light-O-Rama sequence from http://sequences.lightorama.com, you will receive a 

confirmation email with a serial number and link to immediately download it. The download link is at the bottom of the 

email. If you're still in the sequencing store, look under 'My Accounts', 'Track your recent orders' and click 'View Details' 

to find the download link. 

If the sequence includes the music 

Some of our sequences include music, meaning Light-O-Rama has taken care of the licensing requirements for you. The 

music file is included with your sequence to make things easy. Please keep in mind we have arranged for the music to be 

licensed only to you, so copying the music file to share with others is not allowed. Skip the next couple of topics about 

buying the music if downloaded this type of sequence. 

Purchase the music before installing the sequence 

In the sequence store description, we provide a link to where to purchase the music at www.Amazon.com. Purchase and 

download the music to your computer before installing the sequence. 

What if you can’t purchase the music at www.Amazon.com? 

Locate and purchase the music in your country. Make sure the music track length is the same as what is specified in the 

sequence store. Purchase and download the music to your computer before installing your sequence. 

Downloading your sequence(s) from the Light-O-Rama sequence store 

Each Light-O-Rama sequence store order typically involves two or more files to download to your computer. The first file 

is named something like C1234-RTG.zip or C1234-RTG.exe. This is the actual sequence information. Some Internet 

browsers will warn this file might not be safe. We scan the files daily for viruses, so the files should be safe.  

If the downloaded file ends with .zip (it will look something like: C1285-RTG.zip), double click on the file to expand 

the contents.  You’ll see a file name with the sequence part number and an instruction next to it (it will look something 

like: C1285-RTG (double click to install).exe.  Double click the file and follow the instructions.  You’re 

done. 

If the downloaded file ends with .exe (it will look something like: C1285-RTG.exe), double click the file and follow 

the instructions.  You’re done. 

The last file to download is called ReadMeFirst-C68P32.pdf and includes the contents of what you are reading now. 

 

 

http://www.lightorama.com/
http://sequences.lightorama.com/
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ShowTime Sequencing Suite Software Installation 

Purchasing a Software License 

You must have a recent version of the Light-O-Rama ShowTime Sequencing Suite software already installed on your 

computer. If you do not have this software, please go to https://store.lightorama.com/software1.html to purchase the 

product. 

Your sequence was written with the latest version of the ShowTime Sequencing Suite software. It will usually work with 

earlier versions of our software but we always recommend being on the latest version so the best tools are available.  

‘Ready To Go’ and ‘You Can Modify’ base sequences can only be guaranteed to work with our S3 or later software 

(specifically version 3.8.2 and higher). However, we strongly recommend you download the latest version of LOR S5. 

What level of ShowTime Sequencing Suite do you need? 

This base sequence uses 68 regular channels and 32 RGB based pixels. You can always start with just one controller this 

year (controller Unit ID 01 and/or Unit ID 07) and add more controllers later. 

The number of controllers used in the sequence is based on the Light-O-Rama Sequencing Suite software package 

license level installed on your computer. Open the Light-O-Rama Sequence Editor (S4) or Sequencer (S5) and look at the 

window title bar in the upper left to see what license level you have. Depending on the license level, here are the 

controller Unit IDs available for your use: 

• Demo: no controller Unit IDs are used 

• Basic: controller ID's 01 and 02 

• Basic Plus: controller IDs 01, 02, 03 and 04 

• Standard: controller IDs 01, 02, 03, 04, 05, 06, 07 and 08 

• Advanced: controller IDs: all 

• Pro: controller IDs: all (Prepare to use motion paks in the future!) 

Light-O-Rama sequencing software 3.8.2 or later is required to use all the features of this sequence, but we strongly 

recommend using the latest version of LOR S5 rather than S3 or S4. 

If your current level of the Light-O-Rama Sequencing Suite does not include all the controllers you want to use, consider 

an upgrade. Find out more at https://store.lightorama.com/s2soup.html. 

What if I'm using the Demo version of the ShowTime Sequencing Suite 

If your installed Light-O-Rama ShowTime Sequencing Suite says 'Demo' in the top title bar of the window, it does not 

send any control signals to any controllers. This is a free version of the software and meant for testing and 

demonstrations only. Make sure your software says 'Basic', 'Basic Plus', 'Standard', 'Advanced' or ‘Pro’ in the top title bar 

or your sequence will not play. 

 

http://www.lightorama.com/
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Sequence Installation 

How to install the sequence 

Before the sequence is installed, make sure the Light-O-Rama Sequence Suite is already working fine on your computer. 

Once the sequence installation file is downloaded, you will then need to run it to install the sequence information on 

your computer. Locate and double click the downloaded sequence installation filename to start the installation.  

If the downloaded sequence file ends with .zip (it will look something like: C1285-RTG.zip), double click on the 

file to expand the contents.  You’ll see a file name with the sequence part number and an instruction next to it (it will 

look something like: C1285-RTG (double click to install).exe.  Double click the file and follow the 

instructions.   

If the installation program opens a dialog box saying the sequence installer requires Microsoft .NET 3.5 and or Windows 

Framework 3.5 then make sure the computer is on-line and let it download the secure updates from Microsoft. 

If the downloaded sequence file ends with .exe (it will look something like: C1285-RTG.exe), double click the file 

and follow the instructions.   

 

What comes with a sequence purchase? 

Upon the receipt of a Light-O-Rama sequence, you will be receiving one installation file that includes the follow files 

embedded within: 

• A Light-O-Rama sequence file (it ends with “.lms”)  
• The Light-O-Rama sequence installer  
• If music is included, then an audio file (it ends with .mp3)  

o Note: Most sequences do NOT come with audio 

During installation, the sequence installer will put the sequence in your default Light-O-Rama sequence directory. 

If your Light-O-Rama sequence includes music, the installer will put the music file in your default Light-O-Rama audio 
directory. The music file will typically have the same name as the sequence but end with .mp3. You can skip to the next 
topic if your sequence comes with music. 

If your Light-O-Rama sequence does not include the music, we provide a link to purchase the music through 
Amazon.com. The music is licensed directly to you. Amazon embeds a unique identifier in the music file that can be 
tracked back to the original purchase.  

It is important to use the same musical track we specify. Since there can be different versions of the same song by the 
same artist, the light patterns can be off if a music version is different than what the sequencer used. 

The sequence installer will search the computer for the correct music file needed by the sequence, create a copy, put it 
into your default Light-O-Rama audio directory, then attempt to link the sequence to the music. 

Sequence information is placed in the appropriate Light-O-Rama directories created when the Light-O-Rama Sequencing 

Suite software package was installed. Remember: sequences cannot be installed without this package in place.  

http://www.lightorama.com/
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Can’t Find The Audio File?  

Should you open your new sequence in the ShowTime Sequencing Suite Sequence Editor and get a message saying it 

cannot find the audio file or cannot get the last modification time, go to Edit -> Media File if you’re using LOR 

S3 or S4, or Sequence -> Media File in LOR S5 to browse to the appropriate music file (typically in your default 

Light-O-Rama Audio directory) and select it. Once you’ve selected the media file, save your sequence. Do not move your 

audio file or your sequence after this point or you will need to repeat the process. 

 

‘Can’t init conversion’ (Audio File) 

This is programmer speak for ‘your music file is something I don’t understand’ and can happen if you’re running a 

version 3.9 or earlier of Light-O-Rama software. You can usually fix things by going to this website: http://audio.online-

convert.com/convert-to-mp3. Upload your music, it will convert it to a standard format (CBR, 128kbps, .mp3) and 

download the converted music back to your computer.  

 

Troubleshooting - Music is not the right volume compared to other songs 

The recording artist has full creative control of what you hear. Unfortunately, some like it soft and others like it VERY 

loud. There's a technique known as 'normalization' that attempts to make the audio you hear more consistent. This is 

typically a one-time process that will adjust the music levels as needed in the computer file.  

We've had good success using a free program called Audacity (http://www.audacityteam.org). Download and install 

Audacity on your computer. We recommend using the standard .mp3 file format so be sure to also download the 'LAME 

MP3 encoder' from Audacity (http://www.audacityteam.org/download/windows/) and Audacity will read/write .mp3 

files. Start Audacity, open the audio file used by the sequence, go to Effects->Normalize, use the default value and watch 

the magic. One special note:  Save or export the Audacity normalized audio file back to your default Light-O-Rama Audio 

directory. Best practice is to rename the new file and leave the original file alone. Make sure this new file is linked to the 

sequence (open the sequence in the S4 Sequence Editor and goto Edit->Media File, or the S5 Sequencer and goto 

Sequence-> Media File) and you're good to go. Still perplexed by all this?  Ask a teenager for help. 

Another normalization option is to use an on-line service. Upload the music file. Let the service work the magic and 

download the normalized file. A good example is http://audio.online-convert.com/convert-to-mp3. Browse to your 

music file typically in the default Light-O-Rama Audio directory, select it, leave the 'optional settings' alone, check the 

'Normalize audio' option and click 'Convert file'. Wait for your file to upload and convert then watch for the dialog box to 

downloaded the 'normalized' audio. Save the normalized audio file back to your default Light-O-Rama Audio directory. 

Best practice is to rename the new file and leave the original file alone. Make sure this new file is linked to the sequence 

(open the sequence in Sequence Editor and goto Edit->Media File) and you're good to go. 

There are other normalization options available. Do an Internet search on 'music normalization'   

 

No ShowTime Sequencing Suite but still want the sequence? 

Store the installation file in a safe place. Once you have the ShowTime Sequencing Suite installed, licensed, and running 

on your computer, then install the sequence as explained earlier. 

 

http://www.lightorama.com/
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Light-O-Rama Directories 
Typical default paths for Light-O-Rama directories referenced in this document:  

• Sequences:  Local Disk (C:) > Users > name > Documents > Light-O-Rama > Sequences   (Your default path might 

be slightly different.) 

• Audio/Music:  Local Disk (C:) > Users > name > Documents > Light-O-Rama > Audio   (Your default path might be 

slightly different.) 

• Instructions: Local Disk (C:) > Users > name > Documents > Light-O-Rama > Sequences   (Your default path might 

be slightly different.) 

File Names – What do the extensions mean? 
The -C68P32 in the sequence name means the sequence uses 68 channels and 32 pixels. 

The -RFM in the sequence name means royalty free music is used and is included with the sequence. No extra music 

licensing is necessary. 

The -YCM in the sequence name means it is a 'You Can Modify' sequence. You have the full source code and can change 

any part of the sequence including reassigning Unit IDs and adding more controllers (if your license level allows it.) 

The -RTG in the sequence name means it is a 'Ready To Go' sequence and cannot be modified by you in any way. The 

sequence is encrypted with no access to any effects or controller/channel assignments. 

If the sequence did not include the music, in most cases we found the licensed music file already on your computer, 

copied it to the default Light-O-Rama Audio directory, renamed the music file slightly to match the sequence name, 

added -SN at the end of the filename and linked the music to your new sequence.  

If the sequence includes the music, we placed the music file in the default Light-O-Rama Audio directory. It's the same 

name as the sequence, has -SN at the end of the filename, is saved in the .mp3 format and linked to your new sequence.  

The -SN in the music file name means we converted it to a standard CBR, 128kbps, .mp3 format and attempted to 

normalize the volume. You might need to go through the ‘Can’t find the audio file?’ section above to link the converted 

music back to your sequence.  

  

http://www.lightorama.com/
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Building a “Show” on your computer (A Playlist of Sequences) 
This sequence and your legally licensed music will play fine on your computer through the ShowTime Sequencing Suite 

Sequence Editor (S4) or Sequencer (S5). To run the sequence in a playlist with other sequences, it needs to be converted 

to a “show.” See your ShowTime Sequencing Suite on-line help for more information about the “Show Editor” and 

“Schedule Editor.” 

Using your purchased sequence with a ShowTime Director 
Light-O-Rama's ShowTime Directors allow you to run sequences without a dedicated computer. You can use the Light-O-

Rama Hub to build a show playlist that will write to an SD card. You must have Light-O-Rama sequencing software 4.4.0 

or higher to use the Hub. See more information at 

https://www1.lightorama.com/downloads/5.6.0/help/creating_a_new_sd_card_show.htm. 

'Ready To Go' sequences (look for -RTG in the sequence name) can be used with Light-O-Rama ShowTime Directors if 
you are using our S3 software version 3.8 or higher. Previous versions of the software do not allow ‘Ready To Go’ 
sequences to run on ShowTime Directors. For assistance using a Showtime Director with LOR S3 or early versions of S4, 
please see the Help file: https://www1.lightorama.com/downloads/3.8.2/LORHelp.pdf. 

‘You Can Modify’ sequences (look for -YCM in the sequence name) can be used with Light-O-Rama ShowTime Directors 
using almost any version of our software. 

 

 

Please don't share your Sequence  
Each sequence has an embedded transaction number we use to link back to your original purchase. Do not share your 

sequence with anyone, regardless of any modifications you make. We monitor all social media, sharing sites, and online 

stores for people that might be sharing our sequences, and can identify the original purchaser. In short, please do not 

share your purchased sequences. We WILL trace it back to you. 

Commercial use 
Using most musical sequences in a commercial environment means performance licensing. You can do this for each song 

by contacting each artist directly, or it is much easier to work with the American Society of Composers, Authors and 

Publishers (ASCAP). Contact ASCAP at www.ASCAP.com or call 1-800-505-4052. 

 

Want more performance licensing information?  ASCAP provides thorough explanations at 

www.ascap.com/licensing/licensingfaq.aspx  

http://www.lightorama.com/
http://www.ascap.com/
http://www.ascap.com/licensing/licensingfaq.aspx
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Modifying Your Sequences (YCM) 
If your sequence is designated 'You Can Modify' (look for -YCM in the sequence name) then you can change the light 

patterns and add/edit/delete controllers and light channels as you see fit through the ShowTime Sequencing Suite 

Sequence Editor (S4) or Sequencer (S5). You can use your sequence as a starting point to build something customized for 

your display! 

Pro Tip: if you change the sequence, save it as a different name. If you make a mistake you can return to the original 

sequence and start again. Don’t forget to backup your files. 

 

Converting a ‘Ready To Go’ Sequence to a ‘You Can Modify’ Sequence 

There is no capability to automatically upgrade a ‘Ready To Go’ sequence to a fully editable ‘You Can Modify’ sequence. 

You will need to purchase the sequence from the Light-O-Rama store as a ‘You Can Modify’ sequence if you want to 

make your own changes. 

 

Modification Suggestions 

Your guests will react to three things: 

1. Lights 

2. Music 

3. The lights flashing in perfect time to the music 

Keep things simple and don’t get bogged down in all the technical stuff. If you don’t want to learn how to sequence on 

your own (or don’t have time), that’s why we have the option of our “Ready to Go” sequences.  

 

Sequencing Help 

We have lots of tutorials to help get you started with sequencing modifications. You can read about sequencing in our 

help file, or watch tutorials in video form: https://www1.lightorama.com/tutorials/  

If you REALLY need help customizing your sequence, reach out to one of our partners. They know our products inside 

and out and can help you take your display to the next level: https://www1.lightorama.com/partners/  

 

http://www.lightorama.com/
https://www1.lightorama.com/tutorials/
https://www1.lightorama.com/partners/
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Sequence Modification in S3/S4 

Open the -YCM sequence using the ShowTime Sequencing Suite Sequence Editor. You’ll see something like this screen 

on your computer: 

 

You will see little ‘+’ signs next to each Unit ID group. Click the ‘+’ to expand the channels associated with that Unit ID. 

 

Now you can change the effects as desired.  Collapse the channels by pressing the ‘-‘ sign. 

Your sequence only uses one track but there could be several different timing grids depending on how the sequence 

artist interpreted the music. Look in the upper right corner for a timings dropdown arrow and click to see any other grids 

that might be used. 

If your sequence is designated 'Ready To Go' (look for -RTG in the sequence name) then opening the sequence within 

the Sequence Editor will allow you to view only the channel layout and change the audio file linked to the sequence.  

http://www.lightorama.com/
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Sequence Modification in S5 

Open the -YCM sequence using the ShowTime Sequencing Suite Sequencer. You’ll see something like this screen on your 

computer: 

You will see little ‘+’ signs next to each Unit ID group. Click the ‘+’ to expand the channels associated with that Unit ID. 

 

Now you can change the effects as desired.  Collapse the channels by pressing the ‘-‘ sign. 

Your sequence only uses one grid configuration (“Show All Items”) but there could be several different timing grids 

depending on how the sequence artist interpreted the music. Look in the upper right corner for a timings dropdown 

arrow and click to see any other grids that might be used. 

If your sequence is designated 'Ready To Go' (look for -RTG in the sequence name) then opening the sequence within 

the Sequencer will allow you to view only the channel layout and change the audio file linked to the sequence.  

http://www.lightorama.com/
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Sequence Channel Layout (In Table Form) 

AC Controller Layout 

This sequence takes advantage of multiple Light-O-Rama controllers. Controller ID 01 and ID 02 use four groups of four 

light circuits. Controller ID 03 and ID 04 use two groups of eight light circuits. See below for other controllers. We break 

things up into colors or segment numbers just to make it a little easier to understand but you can connect your lights as 

you see fit. 

The drawings on the next pages break the layout down controller by controller. The following table is a quick summary 

so you can have a high level overview in one place. Standard 16 channel controllers (Unit IDs 01 through 06) are below.  

 

channel 
Controller 

ID 01 
Controller 

ID 02 
Controller 

ID 03 
Controller 

ID 04 
Controller 

ID 05 
Controller  

ID 06 

1 Group A - section 1 Fixture E - 1  (red) Arch I - segment 1 Tree K - segment 1 Not used Strobes 

2 Group A - section 2 Fixture F - 1  (red) Arch I - segment 2 Tree K - segment 2 Not used Strobes 

3 Group A - section 3 Fixture G - 1  (red) Arch I - segment 3 Tree K - segment 3 Not used Strobes 

4 Group A - section 4 Fixture H - 1  (red) Arch I - segment 4 Tree K - segment 4 Not used Strobes 

5 Group B - section 1 Fixture E - 2  (green) Arch I - segment 5 Tree K - segment 5 Not used Not used 

6 Group B - section 2 Fixture F - 2  (green) Arch I - segment 6 Tree K - segment 6 Not used Not used 

7 Group B - section 3 Fixture G - 2  (green) Arch I - segment 7 Tree K - segment 7 Not used Not used 

8 Group B - section 4 Fixture H - 2  (green) Arch I - segment 8 Tree K - segment 8 Not used Not used 

9 Group C - section 1 Fixture E - 3  (blue) Arch J - segment 1 Tree L - segment 1 Not used Not used 

10 Group C - section 2 Fixture F - 3  (blue) Arch J - segment 2 Tree L - segment 2 Not used Not used 

11 Group C - section 3 Fixture G - 3  (blue) Arch J - segment 3 Tree L - segment 3 Not used Not used 

12 Group C - section 4 Fixture H - 3  (blue) Arch J - segment 4 Tree L - segment 4 Not used Not used 

13 Group D - section 1 Fixture E - 4  (yellow) Arch J - segment 5 Tree L - segment 5 Not used Not used 

14 Group D - section 2 Fixture F - 4  (yellow) Arch J - segment 6 Tree L - segment 6 Not used Not used 

15 Group D - section 3 Fixture G - 4  (yellow) Arch J - segment 7 Tree L - segment 7 Not used Not used 

16 Group D - section 4 Fixture H - 4  (yellow) Arch J - segment 8 Tree L - segment 8 Not used Not used 

http://www.lightorama.com/
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Dumb RGB Controller Layout 

Standard RGB based Pixel Controllers such as the CMB24D (see the Typical Layout drawing later for this to make more 

sense) 

RGB 
Port 

Controller 
ID 07  

CMB24D 
RGB Channels 

  

1 Dumb pixel P1   1, 2, 3 Group 1 Duplicated at controller ID 20 on channels 1, 2, 3 

2 Dumb pixel P2   4, 5, 6 Group 1 Duplicated at controller ID 21 on channels 1, 2, 3 

3 Dumb pixel P3   7, 8, 9 Group 1 Duplicated at controller ID 22 on channels 1, 2, 3 

4 Dumb pixel P4   10, 11, 12 Group 1 Duplicated at controller ID 23 on channels 1, 2, 3 

5 Dumb pixel P5   13, 14, 15 Group 1 Duplicated at controller ID 24 on channels 1, 2, 3 

6 Dumb pixel P6   16, 17, 18 Group 1 Duplicated at controller ID 25 on channels 1, 2, 3 

7 Dumb pixel P7   19, 20, 21 Group 1 Duplicated at controller ID 26 on channels 1, 2, 3 

8 Dumb pixel P8   22, 23, 24 Group 1 Duplicated at controller ID 27 on channels 1, 2, 3 

 

RGB 
Port 

Controller 
ID 08  

CMB24D 
RGB Channels 

  

1 Dumb pixel P9   1, 2, 3 Group 2 Duplicated at controller ID 28 on channels 1, 2, 3 

2 Dumb pixel P10   4, 5, 6 Group 2 Duplicated at controller ID 29 on channels 1, 2, 3 

3 Dumb pixel P11   7, 8, 9 Group 2 Duplicated at controller ID 2A on channels 1, 2, 3 

4 Dumb pixel P12   10, 11, 12 Group 2 Duplicated at controller ID 2B on channels 1, 2, 3 

5 Dumb pixel P13   13, 14, 15 Group 2 Duplicated at controller ID 2C on channels 1, 2, 3 

6 Dumb pixel P14   16, 17, 18 Group 2 Duplicated at controller ID 2D on channels 1, 2, 3 

7 Dumb pixel P15   19, 20, 21 Group 2 Duplicated at controller ID 2E on channels 1, 2, 3 

8 Dumb pixel P16   22, 23, 24 Group 2 Duplicated at controller ID 2F on channels 1, 2, 3 

 

Keep reading for explanations and pictures in a typical layout. 
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Sequence Store Base Sequence Layout (Full Page) 
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Sequence Channel Layout (In Picture Form) 

 

This can seem intimidating if you are new to animated shows, but we’ll break it down for you. See the previous page for 

a larger version of the above drawing. It shows one example of how 68 channels and 32 pixels could be installed on a 

building. 

The key to success is thinking in small groups. Light patterns typically work best in groups of four or eight because of 

how music is composed. Look carefully at the example and find the groups. Watch the sequence videos and you’ll be 

able to easily pick out the groups of four and eight. 

What’s a group of four or eight?  Think four windows on the second level of the house or eight windows on the first 

level. It could be four sections of bushes or eight segments on a leaping arch. Let your imagination run wild and be 

creative. 

Even though this sequence uses 68 regular channels and 32 RGB based pixels, it works with fewer controllers (channels 

and pixels) attached. Start with just one controller (controller ID 01 and/or ID 07) and add more controllers later. 

The following pages will focus on one controller at a time to make it all easier to understand. 
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 Controller ID 01 

 

If you have only one controller, then this is the one that does the most work. 

Controller ID 01 should be deployed on your main structure to take up the most space possible. The light channels are 

used constantly throughout the entire song and usually highlight the main melody.  

For our example, we’ve used four roof segments, four windows, four bushes and four columns. Your venue might be a 

four-story building, each with four windows. Think “four groups of four” and you’ll line up with our sequences. 
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 Controller ID 02 

 

We suggest controller ID 02 be used with accent pieces, usually with the beats of the song. The light channels are used 

to enhance the first 16 channels used with controller ID 01. They are not required for a good-looking show but you can 

expand into them in the future. We use four separate design elements (fixtures), and each is wired with four different 

colors. See the mini-trees in the yard above. You can certainly use your own configuration such as 16 small objects (like 

candy canes or snowflakes) grouped in sections of four. 
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 Controller ID 03 

 

We suggest controller ID 03 be other accent pieces. The light channels are used to enhance the first 16 channels used 

with controller ID 01. They are not required but you can expand into them in the future. Think two groups of eight. We 

use two leaping arches as design elements, where each is wired with eight different light segments. You can certainly 

use your own configuration such as 16 small objects (like snowflakes) grouped in two different sections of eight. 
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Controller ID 04 

 

We suggest controller ID 04 be other accent pieces. The light channels are used to enhance the first 16 channels used 

with controller ID 01. They are not required but you can expand into them in the future. Think two groups of eight. We 

use two mega-trees of lights as design elements, where each is wired with eight different light segments. You can 

certainly use your own configuration such as 16 small objects grouped in two different sections of eight. 
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 Controller ID 05 

 

Controller ID 05 is purposely not used in the sequence. If you have a ‘You Can Modify’ version of the sequence, use this 

controller to add your own props. Keep the recommendations of fours and eights in mind! 
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 Controller ID 06 

 

We suggest the first four channels of controller ID 06 be used for strobe lights. The sequence typically turns on these 

four channels near the end of the music to mark the finale and give drama. These channels are simply turned on and off 

with no dimming. Connect your random firing strobes or strobe strings.  Channels 5-16 are purposely not used. If you 

have a ‘You Can Modify’ version of the sequence, use these channels to add your own props! 

Although the sequence has 16 channels allocated for controller ID 06, only the first four channels are used, which means 

you could use a four-channel controller instead (not common, but still an option). 

CTB04-PC four channel light controller setting for controller ID 06 (switches 6, 7, 8, 9 are off, ON, ON, off)  

 

(the picture shows switch 8 is on, demonstrating the board is set to controller ID 02). Yours should be set to 06. 
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Controller ID 07 and 20-27 

 

Controller ID 07 is designed for eight RGB pixels and is used constantly during a sequence. We suggest using our 

CMB24D controller with eight dumb pixel ports. Connect dumb RGB ribbons, strings or floods to each port. Since these 

are dumb RGB lights, all the lights on the ribbon or string will be the same color but the sequence can make it any color 

at any time.  

These eight pixels are also duplicated at controller IDs 20-27 and are especially useful with our high-power, single pixel 

floods. 

CMB24D eight RGB pixel controller setting for Unit ID 07 (switches 6, 7, 8, 9 are off, ON, ON, ON)  

 

(the picture shows switch 8 is on, demonstrating the board is set to controller ID 02). Yours should be set to 07. 
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Controller ID 08 and 28-2F 

 

Controller ID 08 is designed for eight RGB pixels and is used as accents during a sequence. We suggest using our 

CMB24D controller with eight dumb pixel ports. Connect dumb RGB ribbons, strings or floods to each port. Since these 

are dumb RGB lights, all the lights on the ribbon or string will be the same color but the sequence can make it any color 

at any time. These 8 pixels are also duplicated at controller IDs 28-2F and are especially useful with our high-power, 

single pixel floods. 

CMB24D eight RGB pixel controller setting for Unit ID 08 (switches 6, 7, 8, 9 are ON, off, off, off)  

 

(the picture shows switch 8 is on, demonstrating the board is set to controller ID 02). Yours should be set to 08. 
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